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Assignment 2
 

Business Letter 
 

Sometimes you need to communicate a 
message to a superior or authority figure 
with whom you do not have an informal 
relationship.  For the purpose of this lesson, 
we draft a letter that you might send to a 
professor or instructor to request a meeting.  
In this case, your reader probably does not 
know you personally, so you need to be 
clear and direct in every aspect of your 
communication to ensure your message is 
received and completely understood.  The 
best way to achieve this goal is to use a 
standard form of professional 
communication that is simple, contains all 
pertinent information related to the 
message, and delivers it in a simple and 
organized manner that readers in any field 
will find recognizable.   

Professional letter might be a better name 
than Business letter for this document, 
because you can use this type of letter for 

more than just business correspondence.  
This letter is based on the traditional full-
block format, which means all fields of the 
letter (return address, recipient address, 
signature, date, body, etc.)  are aligned to 
the left.   

You need to take care when communicating 
with authority figures because these people 
are often decision-makers and you will want 
to cultivate your reputation as an effective 
communicator.  Your ability to construct a 
professional letter not only shows respect 
for your reader through your attention to 
detail, but also demonstrates that you can 
be trusted to communicate in a professional 
manner.  Just one spelling mistake can 
damage that reputation, or worse, send the 
wrong message.  It is in your best interest to 
review your letter more than once before 
you send it. 
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Open Microsoft Word 2010 
 
Open Microsoft Word 2010.  Before you do anything else, you know what to do:  save 
your file.   
 

 
Figure 2-1 – The Quick Access Toolbar 
 
 
 

Save The File 
 

  Select the Save button on the Quick Access toolbar or hold CTRL and hit S 
(CTRL+S) on the keyboard to save.   
 

 
Figure 2-2 – Saving the file as “Assignment 1” 
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Modifying Paragraph Settings 
 
Before you start typing, you need to modify 
the paragraph settings.  Find the small 
arrow in the bottom right-hand corner of 
the Paragraph panel and click it to open 
the Paragraph window.  You will see the 
Indents and Spacing tab open in the 
Paragraph window.  Under General, set 
the alignment to Justified.   

 
Figure 2-3 – Opening the Paragraph 
window 

 
You can also set it to Left if you prefer, but we’ll use Justified in this example. Leave the 
Indentation settings alone.  In the Spacing area, set Before and After both to 0 and 
change Line Spacing to Single.   
  
Click the Set as Default 
button at the bottom of the 
window and set the default to 
this document only, or All 
Documents Based on the 
Normal template, if you would 
like.  This will make the 
settings you just configured 
the default settings for this 
document, and All Documents 
Based on the Normal 
template if you selected that 
option.  If you did not select 
that option, the default 
settings for Word 2010 are 10 
pts. of space After, and line 
spacing of 1.15.  Hit OK to 
close the window and save 
the settings you have 
configured.   

  
 Figure 2-4 – Configuring Indents and Spacing 
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Typing the Letter 
 

Now you are ready to start typing.  Begin 
with typing your full name, and then hit 
ENTER to start a new line.  Type your 
mailing address (known as the return 
address), putting the city, state, and ZIP 
code on a third line by hitting ENTER after 
typing your street number and name.  Hit 
ENTER 3 times to create two spaces.  
Now you need to add the date.   

 

 
 Figure 2-5 – Typing Your Address 

 
You can type it, or you can select Date & 
Time from the Text panel under the Insert 
to bring up the Date and Time window.  
Select the date format that shows the 
month, the day and the year.    
  
 Figure 2-6 – Insert Date & Time 
 

 
Figure 2-7 – Inserting Date and Time Window Figure 2-8 – Adding the Date 
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Hit ENTER 3 times again to create two 
more spaces and then type the name of 
the recipient.  Use their formal professional 
title.  Hit ENTER and type the mailing 
address of the recipient like you did for 
yourself above.   

 
  
 Figure 2-9 – Recipient’s Address 
  

Hit ENTER 3 times and type the word 
Dear, the title of the recipient, and his/her 
last name, followed by a colon.  This part 
of the letter is called the salutation.  Hit 
ENTER 3 times and then begin the body of 
your message.  In our example, we begin 
by clearly stating the purpose of the letter.  
Do not indent the paragraph.  All lines 
should begin at the left margin of the page 
as shown in the example.   

  
 Figure 2-10 – Typing the Salutation 
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Figure 2-11 – The Start of the Body 
  
If you are addressing more than one topic in your letter, you mind find it helpful to use 
bullet points to differentiate between each topic.  In the case of our example, you will 
use the bullet points to outline each of the items you’d like to discuss with Dr. Williams.  
After noting that you will outline each of the items below, end the sentence with a colon 
and then hit ENTER twice to add a space and start a new line.   
 
Now select the Bullets tool from the 
Paragraph panel under the Home tab.  A 
bullet will appear along with the insertion 
point ready to place text to its right.   

 
Figure 2-12 – Selecting the Bullet Tool 

 
Notice that the bullet point is indented to the right a bit.  This is acceptable for the 
purpose of our letter.  If you would like to increase or decrease the amount of 
indentation for these bullet points, you can use the Increase Indent and Decrease 
Indent tools from the Paragraph panel.  In the example, let’s increase the indent by 
selecting the Increase Indent tool just one time. 
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Figure 2-13 – The First Bullet Figure 2-14 – Increasing the Indent 
  
Type each of the topics to be bulleted, hitting ENTER at the end of each to end the topic 
and start a new bullet.  At the end of your last bullet, hit ENTER 3 times.  This will toggle 
the Bullet tool off, create a space, and start a new line.  Finish your message by 
providing the best way to contact you and thank the reader for their time. 
 

 
Figure 2-15 – The Bulleted List and Message Conclusion 
 
Hit ENTER 3 times and then type the word Sincerely followed by a comma.  Now hit 
ENTER 5 times and type your full name.  The 5 spaces will allow you enough space 
place your signature on the letter between the word Sincerely and your printed name 
after you print the letter.   
 

 
Figure 2-16 – The Signature  



1‐8 

Vertical Alignment 
 
Right now your letter starts at the very top 
of the page.  You can give your letter a 
refined look by aligning the content 
vertically to the center of the page.  Rather 
than starting at the top of the page and 
extending down, your copy will grow from 
the center of the page so that it exists in 
the exact center of the page.  To set the 
vertical alignment of your letter, select the 
small arrow in the bottom right-hand 
corner of the Page Setup panel under the 
Page Layout tab.   

 
Figure 2-17 – Setting the Vertical 
Alignment 

 

 
In the Page Setup window, 
select the Layout tab and find 
the Page section.  Change 
Vertical alignment from Top to 
Center.  Hit OK to save the 
changes.   

 
 Figure 2-18 – Setting the Vertical Alignment 
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Save The File 
 

  Select the Save button on the Quick Access toolbar or hold CTRL and hit S 
(CTRL+S) on the keyboard to save.   
 
 
 

Proofing 
 
Spelling, grammar, and word usage are important in every document you create, but in 
professional communication it is imperative that you avoid these mistakes because they 
will negatively affect your communication and your reputation, sometimes resulting in 
irreversible consequences.  Keep in mind the time-old phrase, “you never get a second 
chance to make a first impression.” 
 
Of course, you yourself should review your own work thoroughly, but mistakes are 
inevitable.  Probably the best way to ensure your documents are error-free is to ask 
someone who you trust and respect to review your work, looking for mistakes and 
making suggestions for unclear/confusing language.  Word has tools designed 
specifically for collaborative editing under the Review tab on the Comments, Tracking, 
and Changes panels, which we will consider in another assignment.  Word also has 
tools to help you review and polish your documents on your own.  The Spelling & 
Grammar and Thesaurus tools can help you eliminate major errors, making the job of 
your proofreader much easier.   
 
 
 

Spelling & Grammar 
 
In the last assignment, we quickly reviewed a portion of the Spelling & Grammar tool’s 
functionality.  Words underlined in a wavy red line were identified as misspelled 
according to Word’s dictionary, and words/phrases underlined in a wavy green line are 
considered grammar errors according to Word.  Word will also underline some words in 
a wavy blue line that it believes are contextual spelling errors.  For example, Word will 
see that the word “their” is spelled correctly, but it may also notice that you meant to use 
the word “there”.  You can right-click on the errors and select a correction from the 
selection of possible correct versions in the menu that appears.  You can choose to 
ignore a spelling error by selecting Ignore.  You can ignore all instances of the 
misspelled word by selecting Ignore All, but if the word is spelled properly and Word still 
identifies it as misspelled, you should select Add to Dictionary.  Adding the word to the 
dictionary will ensure that it will appear as spelled properly in every document you 
create from then on.  You can choose to correct or ignore a grammar error.   
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Figure 2-19 – Correcting Spelling 
Errors 

Figure 2-20 – Correcting Grammar 
Errors 

  
Notice the disclaimer for these indicators:  Word only alerts you of errors that it can 
recognize.  And believe it or not, sometimes Word gets it wrong.  Some newer words or 
names are not in Word’s dictionary, and sometimes Word does not understand what 
your words mean.  Sometimes, Word does not catch your spelling or grammar errors 
because it doesn’t recognize any problems.  In any case, you should review all spelling 
and grammar errors that Word does identify because chances are if Word doesn’t 
understand your meaning, your reader may not understand you either.   
 
You can also select the Spelling & Grammar tool from the Proofing panel under the 
Review tab to open the Spelling and Grammar window.  The Spelling and Grammar 
window allows you to work through each error that word has identified with the option to 
ignore or change the error to a correct version listed as a Suggestion.   

 

 
Figure 2-21 – Spelling Error in the Spelling and Grammar Window 
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Figure 2-22 – Grammar Error in the Spelling and Grammar Window 
 
 
 

Thesaurus 
 
Another way you can polish your writing is to vary the words that you use.  By 
expanding your active vocabulary you can keep the reader interested, be more specific 
when necessary, and appear to have a strong control of language.  Word includes a 
thesaurus that can automatically suggest similar or opposite words to words you have 
already used.     
 

You can quickly access thesaurus 
suggestions by right-clicking on 
the word you’d like to change and 
selecting a different word from the 
suggestions listed in the 
Synonyms section of the menu 
that appears.   To dig deeper, 
select Thesaurus from the list or 
you can open the thesaurus from 
the Proofing panel under the 
Review tab. 

 
Figure 2-23 – Synonyms for the word 
“Engagement” 
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The Thesaurus opens in 
the Research panel on the 
left side of the screen.  
Here you will be able to 
search for specific words, 
view all suggestions, and 
lookup suggestions for the 
words that appear in the 
thesaurus.  Just click the 
word to look up 
suggestions for it.  You 
can click the upside-down 
triangle next to each word 
to insert it into the 
document or copy it to the 
clipboard.   

 
Figure 2-24 – The Research Panel:  Synonyms for the word “Engagement” 
 
One word of caution: again, Word can make mistakes.  Sometimes thesaurus 
suggestions may not make sense.  Make sure that you are positive that the word you 
choose from the thesaurus makes sense the way you are using it.   
 
 
 

SAVE YOUR WORK 
 

  Select the Save button on the Quick Access toolbar or hold CTRL and hit S 
(CTRL+S) on the keyboard to save.   
 
 
 

Print 
 
Select the File tab and then choose the Print option from the left side of the screen.  
You will see a preview of the document on the right side of the screen.  On the left side, 
select the printer you want to use and the number of copies that you’d like to print, and 
then hit the Print button.  We will go over the other print settings another time.  Don’t 
forget to sign the letter.   
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Figure 2-25 – Printing the Note 
 

Congratulations!  You have finished assignment #2.  Thank you so much for your hard 
work.  You can use the file you have saved to create new letters in the future by 
opening the file and editing the copy.   

 
 
 

* World Class CAD Challenge 30-02 * - Create a professional letter, save and print 
the document in less than 30 minutes.  Continue this drill four times, each time 
completing the note in less than 30 minutes to maintain your World Class 
ranking.  
 
 
 
 
 
 
 
 
 


